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Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.
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Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 2 2015

Agency Contact: Carol Durflinger

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Timothy Smith
Invited speaker at 
Graduate Student 
Genetics Seminar

4/6/2015 Davis, CA Airfare & lodging X $1,044 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Research Chemist University of California 
Davis 4/6/2015 04/03/2015-

04/07/2015                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert Cushman

Presentation on the use of 
ultrasonography to 
determine follicle count in 
beef heifers

4/8/2014 Las Cruces, NM Lodging & meals X $469 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Research Physiologist New Mexico State 
University 4/10/2015 04/07/2015-

04/10/2015                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Justin Derner Invited to present two 
lectures 4/14/2015 Sheridan, WY Lodging  X $200 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $100 

Research Leader Sheridan College 4/15/2015 04/13/2015-
04/15/2015                            

BENEFIT SOURCE

University of California 
Davis

BENEFIT SOURCE

New Mexico State 
University

BENEFIT SOURCE

Sheridan College

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

carol.durflinger@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA ARS
Plains Area

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015
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Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-
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Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact:
Andrew Tobin, 
Deputy Director

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Barbara Fecso                      LA Farm Bureau Sugar 
Annual Conference 6/26/2015 New Orleans, LA                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Common Carrier    
Meals

x                  
x $1,500.00 

Director, Dairy & 
Sweeteners Anal

LA Farm Bureau 
Federation, Inc. 6/28/2015 6/26/2015                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jeff Savage 32nd. International 
Sweetener Symposium 7/31/2015

Hyatt Regency, Santa 
Ana Pueblo, New 
Mexico

Common Carrier
x

$500.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $275.00 

Sugar Prog. Analyst, 
Dairy and Sweeteners 
Analysis, EPAS

American Sugar Alliance 8/5/2015 8/2/15-8/5/15 Conference 
Registration fee

x
$875.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Barbara Fecso                      32nd. International 
Sweetener Symposium 7/31/2015

Hyatt Regency, Santa 
Ana Pueblo, New 
Mexico

Common Carrier    
Taxi/Shuttle

x                  
x

$500.00      
$180.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,411.00 

Director, Dairy & 
Sweeteners Analysis American Sugar Alliance 8/5/2015 8/1/15-8/6/15 Conference 

Registration fee x $875.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

US DEPARTMENT OF AGRICULTURE
FARM SERVICE  1353 TRAVEL REPORTS NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

LA Farm Bureau 
Federation, INC

BENEFIT SOURCE

American Sugar Alliance

BENEFIT SOURCE

American Sugar Alliance

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact:
Andrew Tobin, 
Deputy Director

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Andrew M. Liebhold
Origins of Large-scale 
Spatial Synchrony in 
Ecologyand Epidemiology

5/18/2015
Santa Fe 
Institute,Santa Fe, 
NM

Taxi/Shuttle, 
Mileage and 
Parking

x $200.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $100.00 

Research Entomologist Santa Fe Institute 
Working Group 5/21/2015 5/17/15-5/21/15 Transportation x $700.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Alan Ager International Conference 
on Fire Behavior and Risk 5/22/2015 Alghero & Sassari 

Italy Common Carrier
x

$2,200.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,100.00 

Operations Research 
Analyst University of Sassari 5/31/2015 5/21/15-5/31/15 Meals x $500.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Alan Ager
SSAFR 2015 Symposium 
for Systems Analysis in 
Forest Resources 

8/19/2015 Uppsala Sweden Common Carrier

x
$2,200.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging                
Meals x

$1,100.00   
$500.00

Operations Research 
Analyst

Institute for Operations 
Research and the 
Management Sciences

8/23/2015 8/16/15-8/23/15 Parking
x

$100.00 

BENEFIT SOURCE

Sante Fe Institute

BENEFIT SOURCE

University of Sassari

BENEFIT SOURCE

Swedish University of 
Agricultural Sciences

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

US DEPARTMENT OF AGRICULTURE
FOREST SERVICE  1353 TRAVEL REPORTS NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact:
Andrew Tobin, 
Deputy Director

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Emil John Pollak

68TH American Meat 
Science Association 
Reciprocal Meat 
conference

6/14/2015 Lincoln, NE Lodging

x
$166.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging Tax x $27.78 

Center Director University of Nebraska 
and ConAgra Foods 6/17/2015 6/14/15-6/16/15 Meeting 

Registration x $850.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Timothy P. Smith Graduate Student 
Genetics Seminar 4/6/2015 Davis, California Lodging x $432.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Common Carrier x $612.00 

Research Chemist Department of Animal 
Science 4/6/2015 4/3/15-4/7/15                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Levin Flake

The International Seminar 
on the Integration of 
Agribusiness and the 
Judicial System

4/23/2015 Cuiaba, Brazil Common Carrier

x

$1,000.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $300.00 

Senior Economist Farming Federation of 
Mato 4/25/2015 4/21/15-4/26/15 Meals x $300.00 

BENEFIT SOURCE

American Meat Science 
Association

BENEFIT SOURCE

Department of Animal 
Science

BENEFIT SOURCE

Farming Federation of 
Mato

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

 ENT OF AGRICULTURE HEADQUARTERS 1353 TRAV  
HEADQUARTERS 1353 TRAVEL REPORTS NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact:
Andrew Tobin, 
Deputy Director

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Beverly Schmitt

XVII International 
Symposium of the World 
Association of Veterinary 
Laboratory Diagnosticians

6/17/2015 Saskatoon, Canada Common Carrier  
Taxi/Shuttle

                    
x x $700.00      

$50.00     

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $376.00 

Director, National 
Veterinary Service 
Laboratories

World Organization for 
Animal Health 6/17/2015 6/16/15-6/18/15

Per Diem(at Gov 
Rate)                    
Mileage Expense

x                  
x

$270.00      
$48.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Dr. Suelee Robbe-
Austerman

2015 National 
Tuberculosis Meeting (TB) 6/8/2015 Atlanta, GA Common Carrier    

Taxi/Shuttle x                       
$550.00      
$70.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging                
Registration Fee x                       

$675.00      
$200.00

Section Head-DBL/MB National TB Controllers 
Association 6/8/2015 6/7/115-6/12/15 Parking                

Mileage x                       
$65.00        
$45.00

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

World Organization for 
Animal Health

BENEFIT SOURCE

National TB Controllers 
Association

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. DEPARTMENT OF AGRICULTURE
MARKETING 1353 TRAVEL REPORT (APHIS-FSIS) NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Patricia V. Abad

DC Exchange Program-
California Agricultural 
Leadership Program to 
educate DC-based 
decision makers on 
current issues and 
complex challenges facing 
California farmers and 
ranchers.

8/1/2015 Northern Region - 
California

Common Carrier    
Transportation

x                  
x

$1,317.00   
$560.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x                  $800.00 

International Trade 
Specialist

California Agriculture 
Leadership Foundation 8/9/2015 8/1/15-8/10/15 Meals x                  $600.00 

California Agriculture 
Leadership Foundation3

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2015

Agency Contact: Leigh Zarbough

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Mark Miller

Meeting - Best Practices 
& New Opportunities for 
improving the measure 
and estimation of crops 
yields in smallholder 
farming systems

6/30/2015 Rome, Italy Lodging x 576

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x 396

Director, International 
Programs

Bill & Melinda Gates 
Foundation & FAO of the 
UN

7/3/2015 06/26 - 07/04/2015 Air Transportation x 2159.2

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Zhengwai Yang
Fourth International 
Conference on Agro-
Geoinformatics

7/20/2015 Istanbul, Turkey Air and lodging x $9,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

IT Specialist Istanbul Technical 
University 7/24/2015 07/19 - 07/25/2015                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT SOURCE

Bill & Melinda Gates 
Foundation

BENEFIT SOURCE

Istanbul Technical 
University

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

leigh.zarbough@nass.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
National Agricultural Statistics Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2015

Agency Contact: Leigh Zarbough

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Mark Miller

Meeting - Best Practices 
& New Opportunities for 
improving the measure 
and estimation of crops 
yields in smallholder 
farming systems

6/30/2015 Rome, Italy Lodging x 576

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x 396

Director, International 
Programs

Bill & Melinda Gates 
Foundation & FAO of the 
UN

7/3/2015 06/26 - 07/04/2015 Air Transportation x 2159.2

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Zhengwai Yang
Fourth International 
Conference on Agro-
Geoinformatics

7/20/2015 Istanbul, Turkey Air and lodging x $9,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

IT Specialist Istanbul Technical 
University 7/24/2015 07/19 - 07/25/2015                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT SOURCE

Bill & Melinda Gates 
Foundation

BENEFIT SOURCE

Istanbul Technical 
University

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

leigh.zarbough@nass.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
National Agricultural Statistics Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact:
Andrew Tobin, 
Deputy Director

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Bianca Moebius-Clune
Soil Measurement 
Committee Mtg. of the soil 
Renaissance.

4/21/2015
Admore, Oklahoma, 
Noble Foundation 
Campus

Lodging
x

$250.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $150.00 

Director, Soil Health 
Division

Noble Foundation and 
Farm Foundation 4/23/2015 4/21/15-4/23/15 Transportation x $100.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Diane E. Stott Seminar Series on Soil 
Health 6/5/2015 Lubbock, Texas Common Carrier x $370.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $200.00 

National Soil Health 
Specialist

Texas Tech University, 
Department of Plant and 
Soil Science

6/5/2015 6/4/15-6/6/15 Per Diem (at Gov 
Rate) x

$46.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

John W. Tuttle
Colorado School of Mines 
Trng. And Geophysical 
Assistance.

7/7/2015 Franklin, NC Lodging

x
$332.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals & IE x $207.00 

Soil Scientist Kathryne E. Sampeck 7/10/2015 7/7/2015-7/10/15                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. DEPARTMENT OF AGRICULTURE
AL RESOURCES CONSERVATION SERVICE 1353 TRAVEL RE NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Noble Foundation and 
Farm Foundation

BENEFIT SOURCE
Texas Tech University, 

Department of Plant and 
soil Science

BENEFIT SOURCE

Illinois State University

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2015

Agency Contact: Kimberly Whittet

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Luis Tupas Steering Committee 
Meeting  9/15/2015 Kobe, Japan Air/Rail 

Transportation X $1,950 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X 750

Deputy Director Asia-Pacific Network for 
Global Change Research 9/19/2015 9/15/2015-9/20/2015 Meals X 300

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Beverly Samuel
Technical Support in 
Establishing Philippines 
EDEN

9/16/2015 Philippines (Multiple 
cities)

Air & Ground 
Transportation X 778

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X 1037

National Program 
Leader

Agricultural Training 
Institute of the Philippines 
Agriculture Department

9/26/2015 9/15/2015-9/20/2015 Meals X 537

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Sonny Ramaswamy
Conference on Soil, Big 
Data, and the Future of 
Agriculture

6/23/2015 Canberra, Australia Air Transportation X 8350

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X 575

Director United States Studies 
Centre 6/25/2015 6/21/2015-6/27/2015 Meals X 300

BENEFIT SOURCE

Asia-Pacific Network for 
Global Change Research 

BENEFIT SOURCE

Agricultural Training 
Institute of the Philippines 

Agriculture Department

BENEFIT SOURCE

American Embassy 
Canberra

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

kwhittet@nifa.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
National Institute of Food and Agriculture

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
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SIGIR
STB
TVA
PCB
PRESIDIO
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USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact:
Andrew Tobin, 
Deputy Director

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert Tse Grow Riverside, The 
Future of Local Food 6/11/2015 Riverside, California Lodging x $203.52 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Community Planning & 
Development Specialist The Grow Riverside 6/12/2015 6/10/15-6/12/15                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Ramona Mitchell
OAHMA Annaul 
Affordable Housing 
Conference

6/13/2015 Bend, OR Lodging
x

$336.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $61.00 

Multi-Family Housing 
Prog. Director

Oregon Affordable 
Housing Mngmt. 
Association

5/15/2015 5/12/15-5/15/15                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jay DeLapp
OAHMA Annaul 
Affordable Housing 
Conference

5/13/2015 Bend, OR Lodging
x

$336.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $61.00 

Area Specialist
Oregon Affordable 
Housing Mngmt. 
Association

5/15/2015 5/12/15-5/15/15                            

BENEFIT SOURCE

The Grow Riverside

BENEFIT SOURCE

Oregon Affordable 
Housing Mngmt. 

Association

BENEFIT SOURCE

Oregon Affordable 
Housing Mngmt. 

Association

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. DEPARTMETN OF AGRICULTURE
RURAL DEVELOPMENT 1353 TRAVEL REPORTS NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2015

Agency Contact: Andrew Tobin

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Michael A. Steiner

Mtg. on the UN Global 
Stragtegy to improve 
Agricultural and rural 
Statisticss and Mtg. of 
Scientific Advisory 
Committee

6/23/2016 Rome, Italy Common Carrier x $838.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $466.00 

Mathematical 
Statitiscian

Food & Agriculture 
Organization of the United 
States

6/27/2015 6/21-6/27/15                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Peter Arbuckle CSCAP 2015 Annual 
Conference 8/3/2015 Nebraska City, NE Lodging x $279.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Common Carrier x $600.00 

Technical Information 
Specialist

Iowa State University 
Sustainable Corn 
Coordinated Agricultural 
Project

8/4/2015 8/2/15-8/5/15                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Lori Jean Finch

Workshop on the Future 
of Semantics for 
informaiton management 
in agriculture

7/2/2015 Rome, Italy 
Common Carrier    
Lodging                
Meals

x

$4,106.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

US DEPARTMENT OF AGRICULTURE
SCIENCE 1353 TRAVEL REPORTS (ARS-NASS)

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2014- MARCH 

31, 2015

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2015

3

LOCATION

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Food & Agriculture 
Organization of the 

United States

BENEFIT SOURCE
Iowa State University 

Sustainable Corn 
Coordinated Agricultural 

BENEFIT SOURCE

Bill and Melinda Gates 
Foundation

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Chief, indexing and 
informatics branch

Bill and Melinda Gates 
Foundation 7/3/2015 6/30/15-7/4/15                            

TRAVEL DATE(S)
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